About Extensible Attributes

Extensible attributes are identifiers that you use to further define and track a NIOS object. For example, to specify the location of a network, you can add the predefined attribute *Site* and enter a specific location for the network. You can also specify whether an extensible attribute is required for an object or restrict the values that can be entered when you create a new object.

You can also specify if an extensible attribute is inheritable by other objects in an inheritance chain. When you enable the inheritance of an extensible attribute, all descendants in the inheritance chain can inherit the extensible attribute so you do not have to configure it at all object levels. For example, if you define an extensible attribute for a network, the attribute and its value can be automatically added for DHCP ranges and fixed addresses in the network.

An extensible attribute is inheritable by descendants in an inheritance chain if its definition does not restrict it to objects that are not part of an inheritance chain. The appliance supports this inheritance chain: Network View -> Network Container -> Network -> Range -> Host/Fixed Address/Reservation. A parent object can have descendants at one or more levels. For example, a network view, network container, network, or DHCP range can be a parent object and have descendants at one or more levels, while a host, fixed address, and reservation can only be a descendant, not a parent. You can set an extensible attribute to be inheritable by selecting the *Enable Inheritance* option when you define an attribute. For more information, see Configuring Inheritable Extensible Attributes.

**Note:** Only superusers can configure extensible attributes.

You can use predefined extensible attributes or specify new ones for different objects. The appliance provides the following predefined extensible attributes that you can customize:

- Region
- Country
- State
- Site
- Building
- VLAN
- ReportingSite (Report Clustering)

When you use a predefined attribute, you can modify it and change its name, but you cannot change the type of data it accepts. You can also delete predefined attributes that you do not use. All predefined attributes accept text strings. You can define other settings though, as described in Modifying Extensible Attributes. You can also create your own extensible attributes, as described in Adding Extensible Attributes.

For example, you can configure the predefined attribute *Site* for fixed addresses and hosts, and define a new attribute *Department* for admin groups.

When you configure an extensible attribute, you can specify the following:

- The type of data that admins enter, such as text strings, integers, or email addresses. You can also restrict admins to a list of values.
- Whether admins can enter multiple values
- A default value
- Whether the attribute is required
- Whether the attribute is inheritable
- The objects associated with the attribute, such as admin groups, DNS views, or DHCP networks.
- Whether the appliance makes an entry in the audit log each time an object with the attribute is added or modified.

Activities such as additions, modifications, and deletions of inheritable extensible attributes, are recorded in the audit log. For information about how to use the audit log, see Using the Audit Log.

Figure 8.5 illustrates a network with different device types. Each device is represented as a host in the NIOS appliance database. You can configure *Device Type*, *Location* and *Owner* as required attributes for hosts. Then when admins add hosts, they will be required to enter values for these attributes in the Extensible Attributes tab of the Add Host wizard.

*Figure 8.5 Using Extensible Attributes to Define Network Devices*
After you configure extensible attributes for an object, the attributes become available in the Extensible Attributes tab of the wizard and editor of the corresponding object. Users then add or edit the attribute values, based on your configuration. Users can also specify attributes when searching for data and add attributes as columns in the tables of Grid Manager. For example, you can add the predefined Site attribute as a column in the Records panel of the Zones tab. For information about adding columns to tables, see Customizing Tables.

Users can also group objects in smart folders according to their attributes. For example, a user can create a smart folder that contains all networks in a certain site.

Users can enable the appliance to group members by extensible attributes. For information, see Grouping Members by Extensible Attributes. When you first enable Cloud Network Automation, NIOS installs a set of extensible attributes that are specific for cloud usage. For more information, see Extensible Attributes for Cloud Objects.

**Adding Extensible Attributes**

To add a new extensible attribute:

1. From the Administration tab, select the Extensible Attributes tab.
2. Click the Add icon on any of the toolbars.
3. In the Add Extensible Attribute wizard, complete the following:
   - **Name**: Enter the name of the attribute. This is a required field and is case-sensitive. You can enter up to 128 UTF-8 characters.
   - **Type**: Specify the type of data that you want to capture for an object. Select one of the following:
     - **String**: Select this when the attribute is used to define string values, such as names. When you select this type, the wizard displays the Number of Characters field where you can enter the minimum and maximum number of characters that users can enter.
     - **List**: Select this when you want to define a list of values for the attribute. Users can then select a value from this list. For example, if you want to restrict an attribute to five specific values, you can define the attribute as a List and then list the five values in the List Values section. When a user uses the attribute, they are limited to selecting from one of the five values.
     - **Integer**: Select this when the attribute is used to track whole numbers, such as serial numbers. When you select this type, the wizard displays the Value Limits fields where you can enter the range of allowed values. These values appear in the drop-down list when a user defines the attribute. Click the Add icon to enter values in the table. You can enter up to 64 UTF-8 characters for each value.
     - **Email**: Select this when the attribute is used for email addresses. Email addresses are entered in the format user@domain
1. Select this when the attribute is used for tracking URLs (Uniform Resource Locators). URLs must be entered in a valid format.
2. Select this when the attribute is used for dates. The date value is in YYYY-MM-DD format.
3. Enter additional information about the attribute. You can enter up to 256 UTF-8 characters.

4. Click Next and complete the following:

- **Enable Inheritance**: Select this check box if you want to allow the extensible attribute and its values to be inherited by descendants in an inheritance chain. When you select this check box, inheritance is enabled for network-related objects only. When you select this check box and restrict an attribute to certain objects, then the extensible attribute and its value will be inherited by those objects only.
  
  Note the following:
  - If you create an extensible attribute with inheritance disabled and later enable it, the Descendant Actions dialog box may be displayed with the available options for adding an extensible attribute. For information, see Managing Inheritable Extensible Attributes at the Parent and Descendant Level.
  - If you create an extensible attribute with inheritance enabled and later disable it, the Descendant Actions dialog box may be displayed with the available options for deleting an extensible attribute. For information, see Deleting Inheritable Extensible Attributes Associated with Parent Objects.

- **Allow multiple values**: Select this check box if you want to allow multiple values for this attribute to be set on an object. You cannot change this value for predefined attributes.

- **Restricting synchronization of extensible attributes**

- **Disable sync to MGM**: Select this check box to disable synchronization of extensible attributes from the managed Grid to the Multi-Grid Master. This check box is available only on the managed Grid when it remains joined with the Multi-Grid Master.

- **Default Value**: Enter the default value that the appliance displays for the attribute. Leave this blank if there is no default value for this attribute. If the attribute type is String, you can enter up to 256 UTF-8 characters. If the attribute type is List, the value must be one of the list values and can be up to 64 UTF-8 characters.

- **Required**: If you select this option, it is required to enter a value for this attribute when adding or modifying the corresponding object in the GUI.

- **Recommended**: If you select this option, it is recommended to enter a value for this attribute when adding or modifying the corresponding object in the GUI.

- **Optional**: This is selected by default. By selecting this option, you may or may not enter a value for this attribute when adding or modifying the corresponding object in the GUI.

- **Restrict to Specific Object Types**: Click the Add icon to select the object type with which you want to associate the attribute. The appliance adds a row to the table. To delete an object type, select an object type and click the Delete icon. By default, the appliance associates an extensible attribute with all the supported object types.

- **Log Attribute Values When Objects are Updated**: Select this check box if you want the appliance to make an entry in the audit log each time an object with this attribute is added or modified. When you select attribute values for audit, they are included in all the audit log entries. For information about the audit log, see Using the Audit Log.

- **Allow cloud members to have the following access to this extensible attribute**: Select this if you are configuring this extensible attribute for Cloud Network Automation. When you select this check box, the Cloud Platform Appliance can access this extensible attribute and perform requested tasks based on the cloud API requests. This function is enabled by default for all cloud-specific extensible attributes. Note that if you disable this function for any cloud attributes, you will receive an error when you try to perform tasks that involve these attributes through cloud API requests. You can select Read/Write or Read only. For information about this feature, see Deploying Cloud Network Automation.
  
  - **Read/Write (and disallow Write access from the GUI and the standard API)**: When you select this, the Cloud Platform Appliance can access and modify the value of this extensible attribute based on the tasks requested only through cloud API requests. You cannot modify this attribute using Grid Manager or the Infoblox API.
  
  - **Read only**: When you select this, the Cloud Platform Appliance can access this extensible attribute and report the value based on the cloud API requests, but it cannot modify the value. You receive an error if you try to modify this attribute when this option is selected.

5. Save the configuration and click Restart if it appears at the top of the screen.

Grid Manager adds the attribute to the Extensible Attributes tab in either the wizard or editor for the specified object types.

**Note**: Infoblox recommends that you define values for mandatory extensible attributes using the Grid only and do not use PAPI or RESTful API to define values.

### Configuring Inheritable Extensible Attributes

An extensible attribute can be inherited by descendants when it is at the top or in the middle of the inheritance chain. When you add a new extensible attribute to a parent object, the same extensible attribute may or may not already exist at the descendant levels. If the extensible attribute exists on a descendant, you can choose to have the descendant inherit the value from the parent, or retain the original value from the descendant. When the extensible attribute does not exist on the descendant, you can choose to have the descendant either inherit the extensible attribute and its value from the parent or not inherit anything from the parent.

When you add a range, host, fixed address or IPv4 reservation to a parent object which has inheritable extensible attributes, the newly added object can inherit extensible attributes from the parent object. For example, if you create an IPv4 network with inheritable extensible attributes, and then add a host, the values you specified for the extensible attributes while creating the network can be inherited by the host.

To assist you in identifying whether an extensible attribute value is inherited or overridden, the appliance displays the inheritance state of an attribute in the Inheritance State column of an extensible attribute. This column is displayed only for objects that support inheritance. For
The extensible attribute overrides the value inherited from the parent. You can change the state to **Inherited**. You can change the state to **Overridden** and then change the value of the attribute or change the state to **Not Inherited** to remove the inherited value.

<table>
<thead>
<tr>
<th>Inheritance</th>
<th>State Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherited</td>
<td>The extensible attribute inherits its value from the parent. You cannot edit the value of an attribute when the inheritance state is set to <strong>Inherited</strong>. You can change the state to <strong>Overridden</strong> and then change the value of the attribute or change the state to <strong>Not Inherited</strong> to remove the inherited value.</td>
</tr>
<tr>
<td>Overridden</td>
<td>The extensible attribute overrides the value inherited from the parent. You can change the state to <strong>Inherited</strong> and restore the original inherited value or change the state to <strong>Not Inherited</strong> and remove the inherited value.</td>
</tr>
<tr>
<td>Not Inherited</td>
<td>The extensible attribute can inherit its value from the parent, but the attribute does not exist on the descendant. You can change the state to <strong>Inherited</strong> and restore the original inherited value or change the state to <strong>Overridden</strong> and change the value of the attribute. Note that when the state of an inheritable extensible attribute is <strong>Not Inherited</strong>, the corresponding attribute will not be added as a new extensible attribute for objects that are currently not inheriting this extensible attribute.</td>
</tr>
<tr>
<td>No Parent</td>
<td>The inheritance state is set to <strong>No Parent</strong> when an object has a parent, but the parent does not have an extensible attribute or the parent's extensible attribute is set to <strong>Not Inherited</strong>.</td>
</tr>
<tr>
<td>Disabled</td>
<td>Extensible attribute inheritance is not enabled for the attribute.</td>
</tr>
<tr>
<td>No Change</td>
<td>The extensible attributes of the selected objects do not have the same inheritance state for all objects. This state allows you to retain the current state on the selected objects. Note that this state is only seen in the <strong>Multi-object Extensible Attributes</strong> editor.</td>
</tr>
</tbody>
</table>

When you add an inheritable extensible attribute to an object, if there are descendants of this object the **Descendant Actions** dialog box is displayed which will provide options for the descendants. Following is a summary of these options:

- Retain the original value of the attribute for all descendants.
- Inherit the extensible attribute and its value from the parent object.
- Inherit the extensible attribute and its value when it does not exist on descendants.
- If the extensible attribute does not exist on the descendant, do not add it.
- If you are deleting an inherited extensible attribute from a parent object you can retain or remove the extensible attribute from the object's descendants.

To configure default descendant actions for inheritable extensible attributes:

1. From the **Grid** tab, select the **Grid Manager** tab, expand the Toolbar and click **Grid Properties -> Edit**.
2. In the **Extensible Attribute Inheritance** tab, complete the following:
   
   **When adding an extensible attribute that already exists on a descendant:**
   
   - **Keep the descendant’s existing value and change the inheritance state to Override:** Select this if you want to retain the existing extensible attribute values for all direct descendants, irrespective of the values you define at the parent level. The inheritance state for all direct descendants will be set to **Overridden**. Note that this is applicable only when you add a new extensible attribute to the parent object that already exists on the descendant. If you modify the value of an existing extensible attribute that is already inherited by the descendant, and select the above option in the Descendant Actions dialog box, then the new value will be inherited by the descendant, but the inheritance state will remain **Inherited**. For example, consider a network 10.0.0.0/16 that has an extensible attribute **Site** with the value **SA** (native). When you add another network 10.0.0.0/24, extensible attribute **Site** inherits its value, **SA**, from the parent object. Now, if you add network 10.0.0.0/8, assign extensible attribute **Site** and set its value to **NY**, then when you choose this option, the value of **Site** will remain as **SA**, but the inheritance state will be changed to **Overridden** for network 10.0.0.0/16; however, network 10.0.0.0/24 will still have its value as **SA** for **Site** with the inheritance state set to **Inherited**.
   - **Inherit the parent's value and change the inheritance state to Inherit:** Select this to inherit the extensible attribute values from the parent for all descendants. The inheritance state for all descendants will be set to **Inherited**.
   - **Change the inheritance state to Inherit only if the descendant's value is the same as the parent's value.**
   - **Otherwise, change the state to Override:** Select this to set the inheritance state to **Inherit** if the descendants have the same extensible attribute value as the parent. Otherwise, retain the original extensible attribute value on the descendants and change the inheritance state to **Overridden**.

When adding an extensible attribute that does not exist on a descendant:

- Do not inherit the value from the parent and change the inheritance state to **Not Inherited**: Select this if the extensible attributes do not exist on the descendants and you do not want them to inherit the attributes from the parent. The inheritance state is set to **Not Inherited**.
- **Inherit the value from the parent and change the inheritance state to Inherited**: Select this if you want all descendants to inherit extensible attributes from the parent, and the inheritance state for all descendants will be set to **Inherited**.

When deleting an extensible attribute:

- **Keep the descendant's value and change the inheritance state to No Parent**: Select this if you want to preserve extensible attributes on all descendants when you delete an inheritable extensible attribute. The inheritance state for direct descendants will be set to **No Parent**.
• If the current inheritance state is Inherited, remove the extensible attribute. If the current inheritance state is Overridden, keep the value and change the inheritance state to No Parent: Select this if you want to remove the extensible attributes that are inherited by the descendants. If the inheritance state of the extensible attributes is set to Inherited on the descendant, the attributes will be removed; however, if the inheritance state is set to Overridden, then the state will be changed to No Parent.

3. Save the configuration.

For more information about how to configure inheritable extensible attributes, see Configuration Examples for Inheritable Extensible Attributes.

Admin Permissions and Inheritable Extensible Attributes
Permissions for descendant objects can affect the results of the actions that are chosen in the Descendant Actions dialog box:

• When you add an extensible attribute to the parent object: The descendants to which you have read-write permission will behave as expected with any of the chosen options in the Descendant Actions dialog box.
• When you change the extensible attribute value on the parent object: The descendants that have the same extensible attribute set to Inherited will be automatically changed to the new value, even though you may not have write permission for those descendants.
• When you select to preserve descendant values while removing an extensible attribute associated with the parent object, values will be preserved even if you do not have read-write permission for those descendants.
• When you select to remove an extensible attribute on descendants when removing a parent's extensible attribute, an error message will be displayed if you do not have read-write permission to some of the descendants.

Guidelines for Configuring Inheritable Extensible Attributes

• When you add an inheritable extensible attribute to a parent object, you can choose to have descendants inherit or override the parent's extensible attribute value. You can also choose that the extensible attribute not be added to a descendant.
• When you add a new parent with an inheritable extensible attribute, the options for changes to descendants remain the same as when you add a new inheritable extensible attribute to a parent. For more information, see Configuring Inheritable Extensible Attributes.
• When you add a new descendant to the existing parent with inheritable attributes, the descendant inherits all the extensible attributes. However, you can select if you want to inherit or override the values. If you set the inheritance state to Not Inherited, then the extensible attribute will not exist on the descendant, but you can later change the state to Inherited or Overridden. For more information, see Managing Inheritable Extensible Attributes at the Parent and Descendant Level.
• When you delete an inheritable extensible attribute associated with the parent, you can either preserve the extensible attribute values on the descendants or delete the inherited extensible attributes. For information, see Deleting Inheritable Extensible Attributes Associated with Parent Objects.
• When you delete a parent object and if there is grandparent, then the extensible attribute will be re-parented when you choose preserve. The current inheritance state of the attribute will be retained. If you delete a parent object and if there is no grandparent, then the inheritance state of the extensible attribute is changed to No Parent when you choose preserve.
• When you split a network, the extensible attribute will be copied to the newly created networks. For inheritable extensible attributes, the newly created network inherits the extensible attributes and the state is set to Inherited. For information, see Managing Inheritable Extensible Attributes at the Parent and Descendant Level.
• When you join two networks to form a larger network, the Descendant Actions dialog box is displayed with the following options: When joining networks, select the action(s) you want to apply to the merged networks:
  • Preserve extensible attributes for all descendants of the merged networks and change the inheritance state to No Parent: Select this if you want to preserve the extensible attributes for all descendants of the merged networks. The inheritance state of the attributes will be changed to No Parent.
  • Remove extensible attributes from descendants of the merged networks: Select this if you want to remove extensible attributes that are inherited by descendants.

Note: The options above apply only to extensible attributes which no longer have a parent, due to the merge. If the extensible attributes on descendants are also on the resulting merged network, then they will retain their current state.

Managing Inheritable Extensible Attributes at the Parent and Descendant Level

You can define if descendants will inherit values from the parent when a new extensible attribute is added to the parent. You can also choose to override the values of the extensible attributes on the descendants.

When you delete an existing attribute, you can choose to either preserve the values at the descendant level or delete the values inherited by the descendants.

Note: The Descendant Actions dialog box is displayed only when an object has descendants and you are modifying extensible attributes that affects those descendants. However, the dialog box is always displayed when a join is performed for a network that has inheritable extensible attributes.

The following section describes configuration changes for inheritable extensible attributes:
1. **Network Container**: From the **Dashboard** tab, select the **Tasks** tab -> click **Add Networks**. Select a network, enter the required details. You can edit the inheritable extensible attributes that are displayed automatically. If this is a parent object, then you can add extensible attributes.

**IPv4 Network**: From the **Data Management** tab -> select the **DHCP** tab -> Networks tab. In the Networks section, select IPv4 Network from the Add drop-down menu. In the **Add IPv4 Network** wizard, enter the attributes in the Extensible Attributes tab after specifying the required details.

**IPv6 Network**: From the **Data Management** tab -> select the **DHCP** tab -> Networks tab. In the Networks section, select IPv6 Network from the Add drop-down menu. In the **Add IPv6 Network** wizard, enter the attributes in the Extensible Attributes tab after specifying the required details.

**IPv4 Range**: From the **Data Management** tab -> select the **DHCP** tab -> Networks tab -> Networks tab -> network > click **addr_range**, select **Range** from the Add drop-down menu. In the **Add IPv4 Range** wizard, enter the attributes in the Extensible Attributes tab after specifying the required details.

**IPv6 Range**: From the **Data Management** tab -> select the **DHCP** tab -> Networks tab -> Networks tab -> network > click **addr_range**, select **Range** from the Add drop-down menu. In the **Add IPv6 Range** wizard, enter the attributes in the Extensible Attributes tab after specifying the required details.

2. You can either add new extensible attributes to the parent object or modify original extensible attribute values. Click on the extensible attribute value displayed in the Value column of the respective attribute to modify the original value or click the Add icon to add a new attribute.

3. Select a state from the drop-down list displayed in the **Inheritance State** column. Note that you can only change the inheritance state of a descendant. You must select **Overridden** from the drop-down list to enter a new value. For more information about inheritance states, see Table 8.2. When an object has a parent and the parent does not have the object's inheritable extensible attribute, then the inheritance state of the extensible attribute is set to **No Parent** and the state cannot be changed.

4. **Select the inheritable extensible attributes for which you want to modify descendant actions**: Select this check box if you would like to apply the actions of the **Descendant Actions** dialog box for existing extensible attributes. Before you select this check box, you must select the extensible attributes which will be affected by the actions of the **Descendant Actions** dialog box.

**Note**: This check box is not displayed for hosts, fixed addresses, and reservations since they do not have descendants.

5. In the **Descendant Actions** dialog box, select options that will be applied for descendant objects as described in Configuring Inheritable Extensible Attributes. The **Descendant Actions** dialog box displays all the mentioned options when you perform add and delete operations simultaneously. Consider an example where you add a new inheritable extensible attribute **Site**, and delete an existing inheritable attribute **Region** from the parent object, and then click **Save** to save both changes. In this case, the **Descendant Actions** dialog box displays all the options.

6. Save the configuration.

**Viewing Extensible Attributes**

To view the configured extensible attributes, from the **Administration** tab, select the **Extensible Attributes** tab. The panel displays the following information:

- **Name**: The name of the extensible attribute.
- **Type**: The type of data defined by the attribute.
- **Comment**: Comments entered for the extensible attribute.
- **Required**: Indicates whether users are required to complete this field.
- **Restricted to Objects**: The object types that are associated with the attribute.
- **Inheritance Enabled**: Indicates whether inheritance is enabled or not. You can do the following in this panel:
  - Sort the displayed data in ascending or descending order by column.
  - Use filters and the **Go to** function to narrow down the list. With the autocomplete feature, you can just enter the first few characters of an object name in the **Go to** field and select the object from the possible matches.
  - Create a quick filter to save frequently used filter criteria. For information, see Using Quick Filters.
  - Modify some of the data in the table. Double click a row of data, and either edit the data in the field or select an item from a drop-down list. Note that some fields are read-only. For more information about this feature, see Modifying Data in Tables.
  - Group results by extensible attributes. For information, see Grouping Results by Extensible Attributes.
  - Add or delete extensible attributes.
  - Print or export the data.

**Modifying Extensible Attributes**

When you modify an extensible attribute, all objects using the modified attributes are updated. You can perform inline editing by double-clicking the row of data that you want to modify. The appliance displays the inline editing editor in the selected row. Click **Save** after modifying the data. Note that you cannot edit extensible attributes that have multiple values.

To modify an extensible attribute:

1. In the **Administration** tab, select the **Extensible Attributes** tab.
2. Select the attribute and click the **Edit** icon.
3. In the **General** tab of the **Extensible Attributes** editor, you can only change the name of the attribute. You cannot change the data type. The data type for predefined attributes is string.
4. In the **Additional Properties** tab, you can modify any of the fields described in step 4 of **Adding Extensible Attributes**.
5. Save the configuration and click **Restart** if it appears at the top of the screen.

### Modifying Inheritable Extensible Attributes

When values are inherited by a descendant, the inheritance state of the inherited extensible attribute is displayed as **Inherited**. You can select **Overridden** and specify a new value or select **Inherited** to retain the same value as the parent. If you select **Not Inherited**, the extensible attribute and its value will not be inherited. The inherited value will have a strike-through and you cannot edit the value when the state is set to **Not Inherited**.

In addition to the attribute values, the **Value** column of an inheritable extensible attribute also displays the name of the source and the object type of the extensible attribute. For example, a **Network Container** has a descendant, **Network**, which inherits an extensible attribute value from **Network Container** and **Network** has a descendant, **Fixed Address** that inherits the same extensible attribute value. In this case, **Fixed Address** shows **Network Container** as the source.

The following table displays various inheritance states and corresponding changes to source and object types that are displayed in the **Value** column of an extensible attribute.

<table>
<thead>
<tr>
<th>Inheritance State</th>
<th>Source and Object Type in the Value Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>If an extensible attribute is a native attribute (an object which is at the top of the inheritance chain, or does not have ancestors),</td>
<td><strong>Source</strong> is not displayed in the <strong>Value</strong> column. This column will not display the source details, if none of the selected objects support inheritance.</td>
</tr>
<tr>
<td>If the state of an extensible attribute is set to <strong>Inherited</strong>,</td>
<td>then the <strong>Source</strong> and object is displayed. You cannot change the value of the extensible attribute.</td>
</tr>
<tr>
<td>If the state of an extensible attribute is set to <strong>Overridden</strong> or <strong>Not Inherited</strong>,</td>
<td>then the <strong>Source</strong> will have a strike-through. You can change the state of such extensible attributes. You cannot change the value of the extensible attribute when the inheritance state is set to <strong>Not Inherited</strong>.</td>
</tr>
</tbody>
</table>

To modify the value and inheritance state of an inheritable extensible attribute:

1. **For IPv4 and IPv6 Network**: From the **Data Management** tab, select the **DHCP** tab -> **Networks** tab -> **Networks** tab -> **Network** -> **addr_range** check box, and then click the **Edit** icon.
   
   **For IPv4 Range, IPv6 Range, Fixed Address, Reservation, and Host**: From the **Data Management** tab > select the **DHCP** tab -> **Networks** tab -> **Network** > click **addr_range**, click the **Edit** icon.

2. In the editor, click the **Extensible Attributes** tab, select the check box of the respective attribute.
3. At the parent level, click on the value you want to change and enter the new value.
4. At the descendant level, click on the value you want to change and enter the new value. Note that you can change the value only when the inheritance state is set to **Overridden**.
5. **Select the inheritable extensible attributes for which you want to modify descendant actions**: Select this check box if you would like to apply the actions of the **Descendant Actions** dialog box for existing extensible attributes. Before you select this check box, select the extensible attributes which will be affected by the actions of the **Descendant Actions** dialog box. For more information about the **Descendant Actions** dialog box, see **Managing Inheritable Extensible Attributes at the Parent and Descendant Level**.
6. Save the configuration.

### Deleting Extensible Attributes

When you delete an extensible attribute, the appliance removes the attribute. All the attribute values set on the selected object types are removed from those objects. Once deleted, the attribute no longer exists in the system. Deleted attributes are not moved to the Recycle Bin. This operation might take a long time depending on the amount of data that needs to be deleted.

To delete extensible attributes:

1. In the **Administration** tab, select the **Extensible Attributes** tab.
2. Select the attribute and click the Delete icon.
3. When the confirmation dialog box appears, click **Yes**.

### Deleting Inheritable Extensible Attributes Associated with Parent Objects

When you remove an inheritable extensible attribute, which is associated with a parent object, you can choose to retain the descendant extensible attribute or remove it from all the descendants.
Note that you cannot delete extensible attributes that have the inheritance state set to *Overridden*, *Inherited*, and *Not Inherited*. You can delete an extensible attribute that is directly assigned to the object and has its inheritance state set to *No Parent* or if the inheritance state is *Disabled*. To remove an inheritable extensible attribute associated with a parent object:

1. **IPv4 and IPv6 Network:** From the Data Management tab, select the DHCP tab -> Networks tab -> Networks tab -> addr_range check box, and then click the Edit icon.

   For IPv4 Range, IPv6 Range, Fixed Address, Reservation, and Host: From the Data Management tab DHCP -> tab -> Networks tab -> Networks tab -> network > click addr_range, select the object and click Edit icon.

2. In the editor, click the Extensible Attributes tab, select the attributes and then click the Delete icon.

3. When you click Save and Close, the Descendant Actions dialog box is displayed automatically with the following options:

   Select the action(s) you want to apply to descendant objects that have the following extensible attribute(s):

   - **Keep the descendant's value and change the inheritance state to No Parent:** Select this if you want to preserve extensible attributes for all descendants. The inheritance state of the extensible attribute changes to No Parent.
   - **If the current inheritance state is Inherited, remove the extensible attribute. If the current inheritance state is Overridden, keep the value and change the inheritance state to No Parent:** Select this if you want to remove the extensible attributes that are inherited by the descendants. If the inheritance state of the extensible attributes is set to Inherited on the descendant, the attributes will be removed; however, if the inheritance state is set to Overridden, then the state will be changed to No Parent.

4. Click Yes to save the configuration or No to exit.

**Note:** The deleted extensible attributes will not be moved to the Recycle Bin and you cannot restore extensible attributes that are deleted.

### Using Extensible Attributes

After a superuser admin configures the attributes of an object, they become available in the wizard and editor of the object. This section describes how users can then add and manage the attributes that were configured.

Grid Manager displays the required extensible attributes in the **Extensible Attribute** tab. You must enter values for all required attributes. If an object does not have required attributes, you can add the available optional attributes.

In the **Extensible Attribute** tab of an object, such as a network or host record, you can do the following:

- Enter values for extensible attributes
- Add attributes
- Change the inheritance state of an extensible attribute
- Select if descendants must inherit extensible attribute values from its parent
- Delete optional attributes

To enter values for the extensible attributes of an object:

1. Open the editor of the object. For example, to enter values for the attributes of a network, select it and click its **Extensible Attributes** tab.
2. Click the Value column of the attribute. You must enter values for all required attributes.
3. Depending on the required attribute type, either enter or select a value for the attribute from the Value column.
4. Based on whether the attribute is inheritable, the values are displayed in the **Inheritance State** column. This value can be set to **Inherited**, **Overridden** or **Not Inherited**. If the object is at the top of the inheritance chain (Network View), then the inheritance state is not displayed. The inheritance state is set to **No Parent** only if an object has a parent, but the parent does not have the inherited extensible attribute. This column is not displayed if all selected objects do not belong to the supported inheritance chain. Example: Zones, DNS View, DNS records, etc.

To add attributes:

1. Click the Add icon. Grid Manager adds a row to the table with the default attribute displayed.
2. Click the default attribute and expand the list of available attributes.
3. Select an attribute from the drop-down list.
4. Enter or select a value for the attribute from the Value column. To delete an attribute:
5. Click the check box beside the attribute you want to delete.
6. Click the Delete icon.

**Note:** You cannot delete an extensible attribute which has its inheritance state set to *Inherited*, *Overridden*, and *Not Inherited*. You can delete an extensible attribute that is directly assigned to the object and has its inheritance state set to *No Parent* or if the inheritance state is *Disabled*.

To delete all attributes:

1. Click the **Attribute Name** check box.
2. Click the Delete icon.

**Note:** You can delete only attributes that are not required. If you have one or more required attributes, you cannot use the delete all function.
3. Save the configuration and click Restart if it appears at the top of the screen.

**Editing Multiple Extensible Attribute Values**

You can also manage the extensible attributes of multiple objects at the same time. For example, you can select several zones, and view and modify their extensible attributes all at once in the Multi-Select Edit Extensible Attributes editor.

Note that Grid Manager may not apply the changes you made to all the selected objects. It applies the change to objects that meet the following criteria:

- You have read/write permission to the object.
- The selected object is not locked by another user or does not have a scheduled pending task.
- If the attribute was restricted to certain object types, the object must be one of those types. To edit multiple extensible attribute values:

1. Select the objects whose extensible attributes you want to modify. You can select specific objects or select all objects in a dataset, as described in Selecting Objects in Tables.
2. Expand the Toolbar and click Extensible Attributes.

Grid Manager displays the Multi-Select Edit Extensible Attributes dialog box which lists the extensible attributes of the selected objects. It displays the following information for each attribute:

- **Attribute Name**: This field displays the name of the extensible attribute associated with the selected object.
- **Value**: If the selected objects have the same value for the attribute, Grid Manager displays that value in this field. If the selected objects have different values for the attribute or if some have values and others do not, this field displays Multiple Values and the cell is highlighted in gray.

An attribute can have multiple rows if it allows multiple values. Grid Manager displays the values that all objects have in common, if any. Otherwise, it displays Multiple Values. This column displays the source for inherited extensible attributes only. Note that when you add new extensible attributes, edit values of existing extensible attributes or delete an extensible attribute, then the Descendant Actions dialog box is displayed, even if the objects do not have any descendants. For more information about Source values, see Modifying Inheritable Extensible Attributes.

- If you select objects that have the same inherited extensible attributes, but objects have different parents, then the Source column will display Multiple Ancestors.
- If the inheritance state of an extensible attribute is Not Inherited, then the extensible attribute will not be added as a new extensible attribute to objects that are currently not inheriting this extensible attribute.
- **Inheritance State**: This field displays the inheritance state of an extensible attribute. The column value can be Inherited, Not Inherited, No Parent, No Change or Overridden. This column is not displayed if all selected objects do not belong to the supported inheritance chain. Example: Zones, DNS View, DNS records, etc.

If extensible attributes for the selected objects have the same inheritance state, then the respective inheritance state is displayed in this column. When objects have different inheritance states, this column displays No Change, so that the current inheritance state is retained on the selected objects. If you then change the inheritance state of an extensible attribute to a specific state, the corresponding attribute will be changed to the selected inheritance state on all selected objects where the extensible attribute is currently inherited. If the object is at the top of the inheritance chain (Network View), then the inheritance state is not displayed. The inheritance state is set to No Parent only if an object has a parent, but the parent does not have the inherited extensible attribute. For more information about inheritance states, see Table 8.2.
- **Required**: This field displays Yes if the attribute is required in at least one object associated with the attribute. It displays No if the attribute is not required in any of the objects.

3. You can do the following:

- Change the value of an attribute. Depending on the attribute type, select the value and either enter a new value or select one from the drop-down list.
- Add an attribute to the selected objects. Click the Add icon. In the Attribute Name field of the new row, select an attribute from the list of available attributes and specify its value. If the attribute that you added was configured as a required attribute, the Required field displays Yes. Otherwise, it displays No.
- Delete an attribute. You can delete an attribute if it is not required. Select the attribute and click the Delete icon.
4. Click OK when you are finished modifying the extensible attributes.

Grid Manager applies your changes to the applicable objects. This operation might take a long time, depending on the amount of data being modified. You can choose to run this operation in the background, as described in About Tasks.

**Grouping Results by Extensible Attributes**

You can enable the appliance to group members and services with the same extensible attributes. Grid Manager displayed group data with the same value for the specified extensible attribute.

To group results by extensible attributes:

1. From the Grid tab, select the Grid Manager tab -> Members tab or Services tab.
2. Complete the following to group members with the same extensible attribute value:

- **Group Results**: Select this check box to enable the appliance to group members by extensible attributes.
- **Group By**: Select an extensible attribute by which you want to group members from the drop-down list.

Grid Manager displays data per group of members configured with the same extensible attribute value.
To add additional Group By filter, click the + icon, and then select a value from the drop-down list. You can apply up to 10 Group By filters. You can also delete a filter by clicking the - icon.